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Membership Director
User Manual

Membership Director is an administrative tool that enables a club's
membership committee (officer) or treasurer to maintain key information
about the club’s members, their dues, contributions, and other necessary
information.  Designed to operate in a Windows environment
(Windows95/98/ME/2000/NT/XP) users will find Membership Director
easy to operate without any training.

A Help file can be accessed at any time by pressing the F1 key on the
keyboard.  A help screen applicable to what is on the screen will be
displayed.

Hardware Requirements

Before installing Membership Director check that your computer meets
the following minimum requirements:

A personal computer with a Pentium processor chip rated with 200
MHz or higher is required.  The faster the processor the better
Membership Director will be able to handle the application's data
manipulations. (Optimum - Pentium 300mhz or better)
16 MB of available memory  (WindowsXP requires 128 MB)
VGA, SVGA, XGA, 8514/A or compatible video graphics adapter
Hard disk with at least 10 MB available
Mouse of equivalent pointing device
Printer

Installation
Membership Director is available either as a download or can be
ordered with a CD.

Installing from the CD
1.  Place the CD in your CDROM drive.
2.  Select the 'Run' menu.
3.  In the run dialog box enter 'D:MD2-SETUP' where 'D:' is your
CDROM drive. If your CDROM drive is something other than D: then
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change it accordingly.
4.  Click OK in the Membership Director v2.0
5.  Click the 'Unzip' in the WinZip Extractor.
6.  Click OK to the message ‘11 files Unzipped Succesfully’
7.  Click OK on the message Missing Runtime Files will now be installed.
8.  On the dBasePlus 2.21 Runtime Engine (and BDE) click 'Next' on the
Destination Folder for the runtime files. The default location is the
c:\memb_dir folder.  We recommend you do not change this.
9. Click 'Next' for the Destination Folder for BDE.  Do not change
destination.
10.  Click Finish
11.  It takes a few seconds for the next screen to come up - Welcome to
the Membership Director Vers. 2.0 Setup Wizard.  Click 'Next'
12. Click the 'I accept the agreement' and 'Next'
13.  Note the Readme.TXT file - for UserID and password – default is
user in both cases.  Click 'Next'
14.  Click 'Next' for the Start Menu folder
15.  Click 'Install'
16.  Click 'Finish'

To Install from the download use the Run on the Start Menu
1.  Select MD201.EXE from the download folder
2.  Complete steps 4 to 16 above

Install Wizard
The first time Membership Director is run the Install Wizard will take
the user through six screens to collect the initial information about the
organization and establish needed lookup codes.  Do not leave these
blanks or you will receive errors as you run the program.  Create at least
on record in each of the lookup codes.  The Install Wizard’s initial screen
advises users of the following sequence.

1  Configuration Screen - allow the user to enter the basic information
about the association and set various preferences.
2  Type of membership - allow you to establish your membership
categories.
3 Financial Accounts - create your income and expenses accounts
4  Committees - allow establishment of association's committees
5 Chapter - create any chapter or sub-organizational units.
6. Contribution – create types of contributions to be received



4

Press the 'Next Setup Screen' button located on the right side of each of
the Install Wizards screens when you have finished establishing the codes
for the page you are on.  Install Wizard then advances to the next screen.
Press the 'Exit' button to exit from Install Wizard without setting up the
codes. The information entered in the Install Wizard’s screens can be
changed later by choosing the 'Configuration' menu.

The Install Wizard does not allow creation of all lookup codes, i.e.
awards and interest.  Use the Configuration menu to create these codes
before using these items.

Converting from Version 1

The menu option 'Convert from Version 1' of the File menu is a special
importing feature for users of Version 1 who desire to transfer their data
from Version 1 to Version 2.

This is a one time opportunity.  Once the data is converted this menu option
will no longer be active.  If the conversion is interrupted the menu option
may not be updated.  Reusing the 'Convert from Version 1' may result in
duplication of records.  To avoid being interrupted be sure you have selected
in Configuration the type of telephone number formatting Version 1 was
using.

By default, Membership Director will look for the Version 1data in the
folder C:\WMember.  If it is unable to find this folder you will need to
direct Membership Director where you installed the earlier version.

Tool Bar

Close Membership Director

Add or Editing Members

 Dues Payment

Contributions Received
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  Email

  Attendance

     Calendar

       Telephone     Help

Menu Bar
The Menu Bar consists of nine menus and is located immediately below
the window title bar and above the tool bar.  The nine menus include:
File File management items (backup, restore, index, import, export)
View  Toolbar (expose or hide)
Members Add/Edit members, email, committees, awards, interests and more
Finances  Write checks, dues, contributions
Other  Attendance, Association History
Reports  Printed lists, summaries, analysis
Labels  Mailing address labels
Configuration Establish lookup codes, set preferences
Help  Help, record registration key

Common Actions for all Screens
The buttons below are commonly found on many data entry screens.

New - new member, new code, new dues payment, etc.

Edit - edit the displayed information.

Delete - Eliminate the displayed information from the data
files.

Save - Save the displayed information.

Exit - quit the current screen, abandoning what has been
entered.
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These buttons enable navigation to the next or previous record like the
next member or code or the previous member or code

Movement on tab pages
Tabs on screens move from page to page.
Tab key on keyboard moves cursor from one data entry field to next
Tab key, when at last data entry on page, moves to first data entry
on next page
Both the Tab key and Enter key on keyboard moves cursor in
browses between columns
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Configuration
Selecting the Organization menu option from the 'Configuration' menu
will activate the 'Organization Configuration' screen.  This screen collects
the basic data about your organization and other important information.

Be sure to complete the following:

Organization Info Page
Record the basic information about your organization.

Email Information:  If you plan to send emails to your members from
within Membership Director enter the requested information.  SMTP is
that of your Internet Provider.  Normally this will be 'SMTP.AOL.COM'
or "MAIL.EARTHLINK.NET" where your ISP data is listed 'SMTP' or
'MAIL'.

Enter your checkbook balance here if not entered with the Setup Wizard.
Once entered you cannot change the amount.
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Preferences Page
Select a Drive for Backup - This is normally the drive holding your

floppy disk - usually Drive A, but it may be a ZIP drive, Super Drive or
external hard drive and their drive designation can be used here.  The default
drive is where Membership Director will place the back up of all data files.
Membership Director cannot backup directly to your CD ROM RW Drive.

Types of labels - 3 Avery label types are available (5160, 5161, 5162).
The 5160 label is 3 labels across and 10 down, the 5161 label is 2 labels
across and 10 down, and the 5162 label is 2 labels across and 7 down.  You
must select one type.  Failure to select a label type will mean that
Membership Director will print nothing - a blank screen.

Printing the organization logo on membership cards and nametags.  The
logo must be a .jpg or .gif image file. To Add Logo - double-click the logo
space.  When the Specify Binary Field Type dialog box appears select
'Image'.  Then the built-in Image View appears.  Right-click on Viewer.  A
File Import dialog box opens.  Select a file of the appropriate type (.jpg,
.gif), and then click OK. NOTE: This window will be minimized.  Find it on
the task bar to complete.

Membership expiration.  Select whether the membership expires on set
date or on anniversary of joining the organization.  If your memberships will
expire on a given date then enter the date and click the 'Change Now' button
to change all members, except life members, to expire on the date entered.

International Formatting
Selecting format for displaying dates (MDY, DMY, YMD).
Selecting the desired form for displaying telephone numbers -US

(999)999-9999 or no format.

Default Page
The User must choose the following Address Label Defaults

Printing envelopes in lieu of address labels
Displaying name with or without spouse name on address label
Showing expiration date on address labels
Displaying title (salutation) with name on address labels

You may choose a default City, State, or Zip/Postal.  This saves having to
enter this information if most of your members are from the same city, state
or have the same zip/postal code.
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Lookup Codes
Lookup Codes are short abbreviations that will differentiate one code
from another.  These codes allow the descriptive name to be displayed in
the various drop-down lists.  When you select an item from a list it is the
code that is stored in the data files not the actual descriptive name.  As
example, a Type of Membership code for 'Active/Regular' could become
'ACT'.  ACT takes up three characters much less than the longer more
descriptive title.

Membership Type Code
Every organization has their own membership categories/types.
Membership Director allows organizations to establish, and use, their
own codes.  These are defined by using the Lookup Code menu option
and Type Member code menu options in the Configuration menu.  The
code is three characters long.  The descriptive name is what will appear
on reports.

Some typical membership types are:
   STU - Student                ACT - Active                       ASS - Associate
   NON - None Member      FUL - Full                           FAM - Family

State Code
This lookup code is best known because it is used everyday.   Everyone
uses the state abbreviation not the full name of the state.  The state lookup
code is the standard two letter abbreviation although a three character
code can be entered for countries that use a three letter abbreviation for
their states.

Chapters
Sub-units of an organization, or Chapters, are often formed to provide
meetings in different locations or meeting on different topics.  A
computer club might have SIG (special interest groups), while a trail club
might have different units through out the state or region.

Committees
All clubs or associations have committees. Membership Director can
track an unlimited number of committees and members assigned to the
committee.
Committee codes are created in 'Configuration' and consist of two
characters.  Typical examples include
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OF Officers (as a group not as
individual)
EX Executive Committee
PU Publication Committee

ME Membership Committee
PR Program Committee
W9 Windows95 SIG

The current officers are designated on the individuals Membership
Information screen.   Individual officers and their positions are also
recorded in the Association History option.   Select the Special menu and
Association History menu option.

Officer/Position
These codes are the position you have within in your organization.  They
consist of two characters, examples VP - Vice President, MD -
Membership Director.  To create:

Select the 'Configuration' menu.
Select Lookup Codes menu option.
Select Office/Position menu option.

Contribution Codes
Most clubs accept donations from both members and non-members.  The
most common type of contribution is cash or volunteer help.  Codes are
created in 'Configuration Menu', Lookup Codes menu option and
Contribution Codes menu option.  Codes are two characters in length.
Typical examples include:

CA Cash
TY Typing
NP New Product

UP Used Product
OF Office help
PA Painting

Country Codes
This lookup code is also well known because it is used frequently.
Everyone uses the country abbreviation not the full name of the country.
The country lookup code is the standard two letter abbreviation. Example:
- US for United States, UK for United Kingdom

If you don't want the country code to be displayed on address labels -
leave the country code blank on the Membership Information Screen.
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Interests (of association members) Codes
Periodic survey of members regarding their interest about your club or the
work of the club can provide helpful information for planning programs,
work projects, or articles in your newsletter.  This keeps the club focused
on the interests of your members.

Adding interest codes are similar to other lookup codes.  Assigning these
codes to your members is the same as adding officer or committee codes to a
member.

Financial Accounts Codes
Financial accounts must be established for all income and expense items that
you want to track.  Most income is from dues and contributions but may
include grants, interest or fees charged members.  Expense accounts include
bank fees, meeting expenses, membership supplies, rental and others.
The codes are three digits long.  Income codes begin with 1, 2 or 3 while
expense codes begin with 4, 5, 6, 7, 8, or 9.  As example – income accounts
101 would be Dues, 102 Contributions, and expense accounts 401 Bank
Fees, 402, Meeting Expenses, 403, Membership Supplies, and so forth.

These codes are established using the Financial Accounts menu option in the
Configuration menu.  The Financial Accounts screen, seen below, is like
other lookup code screens.

Financial accounts cannot be deleted if they are being used in any
transaction.
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Custom Information
Membership Director while being comprehensive in the data collected
cannot anticipate the need for data collection that every organization may
have.  To provide you with the ability to collect this additional data
Membership Director provides you with ten (10) fields that the user can
define/customize to meet their need.

Select the 'User Defined Info' menu option from the Configuration Menu.
For each of the ten fields you need to enter a short descriptive text that
will appear on the User Custom page of the Member Information Screen.
This descriptive text will enable the user to know what to enter.
Field 9 and 10 are date fields.  Only dates may be entered here.  Field 8 is
a numeric field and will only accept numbers.

There are three reports available for the user-defined information.
1.  A listing of members with some content in one specified field.
2.  Search for a particular item in one specified field.
3.  List of members with all the content of a specified field and the member
associated with the info.

Special Flag
A code you create for your members that enable you print group labels or
membership cards.  The code is a single character.  A maximum of five
codes can be entered on the Membership Information Screen - Miscellaneous
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Info page for each member.  There are no lookup codes for the flags you
create.

Examples:  Enter 'SC' for Sponsor, Charter.  Enter 'R' for Organizational
Representive.  Or enter 'SCR' for all three.
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Managing the Members of the Organization

Add or Edit Members

 The Add / Edit button brings up the Membership Information
Screen (see below).  It can also be activated from the Members Menu.
Select the Add New Members menu option.

The Membership Information screen has eight tabs across the top of the
screen.  Each tab will display a screen of related information.

The tabs on this form include:
Find Member   Start here to add new member, edit a previously entered

member or delete a member
Personal Info  Contains member’s info - name, telephone, address, etc.
Membership Info Type membership, expiration, dues paid, etc.
Misc Info   Email, sponsor, photo
Organization  The association this member represents
User Custom  Ten user-defined fields
Activity    Publications, events, contributions
Assignments  Committees, interests and awards
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Find Member Page
The first page of the Membership Information screen ('Find Member')
allows you to locate members already entered or to enter new members.
You can also delete (transfer) a member to the inactive database from this
screen.

This screen, shown on previous page, allows you to find the member
three ways.  Use the first entry field 'Last Name' to locate a previously
entered member by entering first 2-4 characters of the last name. As you
enter these characters the members whose last name begins with the
entered characters will be displayed in the browse/grid located in the
center of the page.  Entering the letter 'c' will display the members with
the last name beginning with the letter entered, or in this case 'c'.  As each
letter is entered the search drills down to the member.  Except for the
most common names entering 3 or four characters should locate the
member.  For common names like Smith enter 'Smith, H' this will locate
the first member with the last name of Smith and the first name beginning
with the letter 'H'.

Use the second entry field 'Member No.' to locate a previously entered
member by entering the member's member number.  As with the 'Last
Name' search, the number entered drills down to the member.  Zeros must
be entered.  Entering '04' will locate the first member whose member
number begins with a '04'.

Use the third entry field 'Organization' to locate members by the
organization they represent. Again, as with the 'Last Name' search,
Membership Director will drill down to the organization.

Note:  Place the cursor in the 'Member No.' and, using a barcode reader,
swipe barcode on the membership card to quickly locate the member.

The push buttons along right side include:
New Member Add new member
Edit    Edit information of member being displayed
Delete   Delete displayed member by transferring them to
inactive data files.
Save  Save information (entire record not just 1 page)
Cancel  Cancel operation and close window

NOTE:  The 'Tab' key moves the cursor from one data entry location to
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another.  Tabbing from the last data entry on one page automatically
moves to the first data entry on next page.  It is not necessary to click the
tabs at the top.

Personal Info Page
This page collects the personal information about the member - name,
address, etc.  It is displayed below.

A "Member No.' is not required.  If used, it can be six numbers or a
combination of a letter and five numbers.  Some clubs use the letter to
designate the type of membership. After entering a number Membership
Director will add leading zeros.  You cannot have duplicate member
numbers.

Again use the TAB key on the keyboard to move from item to item.  In
checkboxes hit the space bar and a check will be inserted.  Or use your
mouse to place a check mark in the appropriate check boxes.

The 'Title' is the mailing title - Mr., Mr. & Mrs., MD, Ms.

A 'Last Name' is required.

Be sure to check the address to be used for mailing. Address labels will
be printed for this address.

Be sure to check the address to be used for mailing. Address labels will
be printed for the address checked.
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Depending on the selection made in Configurations, telephone numbers
will either be displayed in the US format (999)999-9999 or in the free
style 99999999999 for our international users.

When more than one new member has the same information - address,
telephone, etc. use the 'Copy Info to Next' button to copy the contents of
this member.  This button places the information in a buffer. Now start a
new member record and click the 'Paste from Previous Member' button.
This places the information from the previous member in all fields.  Now
change the name, membership number and anything else that is different
and save.

The rest of the first page is routine.  One exception is to leave the country
code blank if you don't want the country to be displayed on the address
labels.  It may be necessary to create a blank country code for this
purpose.

When you tab from the Fax telephone entry Membership Director
automatically advances to the next page 'Membership Info'.  The same
will happen on all pages, as you tab from the last field the next page will
be displayed.  Do not save until all information for this member has been
entered on all screens.

Membership Information Page
A membership type, also referred to as a membership category, is
required.  Be sure to use the Configuration Menu (Membership Codes
menu option) to create these codes and other lookup codes.  The lookup
codes, that you established, will appear in the drop down list.

While entering a new member you can show when the dues payment was
last received.  Do not use this screen to enter dues received, use the Dues
Received toolbar button instead.  The information show here will be
updated automatically when the dues is entered from the dues received
toolbar button.

The expiration date is automatically inserted using the period established
for the membership type.   If the type of memberships covers an annual
period then 365 days are added to the old expiration date.
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Misc Info (Miscellaneous Information) Page
 The email button can be used to send an email message to this member
and this member only.  The Members Menu also contains an email option
where you can send email to one or more members at the same time with
or without an attachment.

The Special Flag holds up to 5 single letter codes to separate labels or
membership cards.  These single character codes are good for things that
you can say yes or no to or something the member either has or they
don't.  These codes cannot be created or edited, they are just something
known to the user.  There are no Lookup codes for the flags you create.
The special flag can be edited as a group or each member individually.
Examples NP - New, probationary; FNC - Free materials, No Dues,
Charter.

Membership Director can store the member's photo.  To do this:
Double click on the photo space to activate the process
When the Specify Binary Field Subtype dialog box appears select

 Image.  The built-in Image Viewer appears.
Right-click on viewer.  A file import dialog box opens.
Select a file of the appropriate type
Click OK

To delete a previously selected photo repeat the processes above but select
the file 'blank.gif' in the c:\memb_dir folder.

Organization Page
Some organizations like the Chamber of Commerce, have members who
are representatives of other businesses or organizations.  This page of the
Membership Information screen allows the organization information to be
collected.

User Custom Page
If you have customized one or more of the ten user-defined fields then the
title you entered will be displayed, otherwise they field labels will be
Member1... Member10.  Use the 'Configuration Menu' and the 'User
Defined Info' menu option to establish these labels.
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Edit Member

Click this button on the tool bar OR select 'Add/Edit Member' from
Member menu.

Use the 'Locate The Member' page to find the member.  Enter the first
few letters of the member’s last name.  As you enter the letters
Membership Director positions the cursor on members with names
beginning with the letters you entered.  Entering a 'S' will position to the
first member with last name starting with 'S'.  Entering 'SM' will position
the browse at 'Smith' but will bypass 'Simmons'.

Click on the 'Edit' button when the member record is highlighted.  Then
select the appropriate tab at the top of the page to find the information
that you intend to edit.

Multiple Member Edit
Select Members menu
Select Multiple Member Edit menu option
Locate the member by entering their last name
Once member is highlighted click the 'Edit' Button
Tab to the field(s) needing to be changed
Make your editorial changes and click the 'Save' button

Remove Member
Membership Director has two remove functions.  One is to completely
delete (remove) a members from the data files.  The other transfers a
member from active data files to inactive data files (See Transfer
Member). A person in the inactive files can be reactivated to active files if
they later rejoin your organization whereas a deleted person would have
to be added again if they return.

There are several reasons to delete or completely remove a member.
Failure to pay annual dues is the primary one for clubs not wanting to
maintain inactive data files but death and failure to leave forwarding
address are two others.

To remove a single member chose the edit a member menu option. In the
'Membership Edit Screen' select the 'Delete' button. Membership
Director will ask you which remove function you want to use.
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Transfer Member
Members may be transferred from the active file to the inactive file,
'Former members' by editing the member and clicking on the delete
button.  The purpose is to save their data should they decide to rejoin the
club at a later date or to provide the information to a later request (See
Reactivate former members to active files).

When the Delete button is depressed there are three options.
Transfer the person. Deletes them from active file and places the data in

the inactive file.
Delete the person.  This removes them completely. It does not place any

information in the inactive file.
Do Nothing

Purging Membership
To transfer all members, who have failed to pay their dues by certain date,
out of the active data files to the inactive (former) datafile, select the menu
option 'Purge Members' on the Members menu. Membership Director will
ask you to enter a date.  All members with expiration dates prior to this date
will be moved to the inactive data file.  You may want to run a report 'Dues
Renewal List Expires Before Date' to see a list of those who will be
transferred to the inactive file before actually purging the membership.

Membership Director will report how may were removed and offer you an
opportunity to review (print list) before the actual removal.

Duplicate Members
Occasionally information is entered about a member more than once.  To
remove duplicate members

Select 'Members' menu from the menu bar.
Select 'Check for Duplicates Members' menu option
After checking, Membership Director will display a list of possible

duplicates.
Print the list.
Edit each member and examine the recorded details to see if they are

duplicates.  If they are select one to edit and delete.
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Barcode Reader

Use of a barcode reader can facilitate locating members in the Membership
Information and Dues Paying screens.  Move the cursor to the 'Member No.'
entry field and then, using a barcode reader, swipe the barcode on the
member's membership card.  The member's member number is automatically
entered and the member's name is highlighted.

Dues Payment Received

Select this button on the tool bar to record payment of dues OR
select the 'Receive Dues Payments' menu option from the Finances menu

Locate the member paying dues using the Find Member screen.  Once the
member has been found click the 'New' button to begin recording the new
dues payment.  The member's current status is displayed at the bottom of the
screen.  Enter the date received, amount received, check number, type of
membership being paid for, and the new expiration date and click the 'Save'
push button.

Membership Director automatically adjusts the expiration date.  It uses the
member's current expiration date, the number of periods being paid for and
the period a particular member type is valid for.  Example: if the type of
membership is valid for a month the member’s expiration is extended one
month from the last expiration period if one period is being paid or three
months if three periods are being paid.

Edit Dues
Select 'Receive Dues Payment' from Finances menu
Locate the member
Click the 'Edit' button
Select the specific dues payment in the lower grid
Select the 'Dues Payment' tab at the top of the page
Make the necessary changes and click the 'Save' button

Dues Renewal Notice
There are two dues renewal notices.  One is for individual members.  The
second is for organizations that are responsible for paying the individual
members dues.  On the Organizations page of the Member Information
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Screen is an item 'Bill Organization for Dues'.  If this is checked then the
second dues renewal notice should be used.

Dues Notice (individual)
A notice is usually sent to members reminding them that their dues will
soon expire.

Select Dues menu option from the Reports Menu.
Select Dues Renewal Notice
Select Individual Members.
Enter expiration date - a notice is printed for all members with

memberships expiring prior to this date.
The bottom portion of the Dues Renewal Notice is returned along with

the dues payment.  This provides the member an opportunity to update their
personal information - address, telephone, etc at the same time they renew.

Dues Notice (Organization)
Select Reports menu
Select Dues menu option
Select Dues Renewal Notice
Last select Dues Notice to Organizations.

Print list of expiring membership
There are two lists available. One is a list with memberships expiring
before a given date and the second for those expiring after a given date.

Select 'Dues' from the Reports Menu.
Select the desired list menu option.
Enter expiration date
When an asterisk appears before the member's name then the dues is

paid by the Organization this member represents.

List of Organization with expiring membership
Select Reports menu
Select Dues menu option
Select Organization Paying Dues for Members menu option

Labels
Select 'Dues' from the Label Menu.
Labels are not essential as the Dues Renewal Notice can be folded

and placed in an envelope with window so the address will show through
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the window.

Dues Payment History
The Dues Payment History which is located on the bottom of the Dues

Payment screen is a quick way to view all the dues payments made by a
member.

To editing the dues payment select the person then click the 'Edit' button
and then click the specific dues payment in the lower Dues Payment History
display.

To delete a dues payment is similar to the editing process just described.
When a dues payment is deleted you have the option to delete it at the same
time from the checkbook.

A Dues Payment History report is available.
The Membership Information Screen (membership page) also shows

the members dues paying history.
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Other Features
Attendance
Membership Director can maintain an attendance record for each
member.

Select 'Other' menu from menu bar and then select 'Record Attendance'
menu option or select the  image from the tool bar.
Enter date of meeting and purpose
Determine how you want to record attendance - by name or member
number.  If you desire to record attendance by member number click the
radio button for 'Record Attendance by Member Number'.  This places
the cursor where the number can be entered.  It can be entered by typing
the member number or by using a barcode reader to scan membership
cards.  Once the number is entered click 'Save & Next'.

If you choose to record Attendance by Member name highlight ‘This
Meeting’ for the first member and use the space bar to place a check in the
box and then the down arrow on the keyboard to position to the next
member, repeating the space bar if they attended or the down arrow to the
next member.  Attendance can be facilitated by the use of the Attendance
Sign In sheet (see reports).  After checking last member click the 'Save'
button.

Edit Attendance
Select 'Attendance' from ‘Other’ menu then Select 'Edit Attendance'
menu option.
Identify the meeting date.
Locate member to be edited.
Remove the check beside the member name, if attendance was recorded
in error, or place a check there if attended and not recorded previously.
Click 'Record Changes' button

Email
To enable the email capability of Membership Director you must
supply, in Configuration, the SMTP server, the password and user id that
your SMTP server will recognize.  Your ISP may have provided you this
in setting up the email and Internet on your computer.

Be sure to record the member's email address in their record using the
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Member Information Screen.  Use the Email Center  image on the tool
bar to identify one or more email recipients and then select the
appropriate button - simple message or message with attachment.
For the simple email just enter

Subject
Message - type or paste the message
Click the 'Send' button

Email with attachment
Subject
Message - type or paste the message
Click the 'Get Attachment and Send' button
Locate the file that will be attached
Click the 'Open' button

Awards
Membership Director maintains the history of awards given by the club.
This module allows entry of the justification for the award and general
information.

First select the  image from the tool bar
Locate the member by entering the first couple characters of the
member's last name.
Click the 'Award Justification' tab located at the top of the screen.
Click the ‘New’ button
Enter the award date, title and justification information.
Click the ‘Save’ button

Committee Assignments
First create the committee codes.

Select the 'Configuration' menu.
Select the 'Lookup Codes' menu option.
Select the 'Committees' menu option.
In the Committee Codes screen create your codes.  Committee codes are

three characters that Membership Director will use when you assign
members to committees.

Examples of Committees are:
 MEM – Membership  FIN – Finance PUB - Publications
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Assign committees to members
Select the 'Members' menu from menu bar.
Select 'Committee Assignments' menu option.
Locate the member on 'Committee Assignment' screen.
Click the 'New' button. Membership Director automatically moves the

cursor to the ‘Pick the Date Assigned’ field and enters the date when the
member was assigned to the committee.

Tab to the 'Pick the Committee to Assign' list.  Select the desired
committee from drop down list and Membership Director will automatically
move the cursor to the Save button.  Hit the Enter key on the keyboard and
the committee will be saved and the cursor set on the ‘New’ button to repeat
the sequence.  The selected committee will appear in the Assigned
Committees grid.

 Editing (removing) committees
Locate the desired member
Highlight the committee to be removed.
Click the Delete button.

Assign Office/Positions to Members
On the Membership Information page of the Member Information Screen the
current officers can be designated.  A report is available to list the current
officers.

Assign Interest codes to Member
Conducting a survey to identify your member’s interests can help you to
identify programs, assign what committee to assign them, utilize their
expertise, or many other ways that help your organization. Membership
Director can maintain this information for you.

First create the interest codes.
Select the 'Configuration' menu.
Select the 'Lookup Codes' menu option.
Select the 'Interests' menu option.
In the Interest Codes screen create your codes.  Interest codes are three

characters long.  Examples of Interests are:

Computer Club: PRO - programming; INT - Internet; WEB – web page
development
Trail Club:  ND - North District; TM - trail maintenance; CC - cross
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country
Garden Club: PER - perennials; WAT - water plants; ROS – roses

Assign codes to members
Select the 'Members' menu from menu bar.
Select 'Member Interests' menu option.
Locate the member on 'Interests Assignment' screen.
Click the 'New' button. Membership Director automatically moves the

cursor to the ‘Pick the Interest to assign’ list.
Select the desired interest code from drop down list and Membership

Director will automatically move the cursor to the ‘Save’ button.
Hit the Enter key on the keyboard and the interest will be saved and the

cursor set on the ‘New’ button to repeat the sequence.  The selected interest
will appear in the Currently Assigned Interests grid.

Editing or removing interest codes
Locate the desired member
Highlight the code to be removed.
Click the Delete button.

Former Members
Transferring them from the active files to the inactive files may retain
information about former members.  This allows their information to be
recalled if someone needs it or to allow the person to be reactivated should
they, at some later time, rejoin the organization.

Reactivate Former Members to Active Files
Select the 'Browse Former Members' menu option on the 'Members'
menu.  Finding the former member is similar to that of finding a member.
Click the 'Edit' button to display the former member's information.  When
the information is displayed, and it is the right person, click the
'Reactivate' push button.

Browse Former Members
Select the 'Browse Former Member' menu option off the 'Member' menu.
Use the 'Find Former Member' screen to locate the former member.

You may:
 Reactivate - restore to active files if rejoins the association
 Delete   - from the inactive file
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 See Details  - view the data for the former member. Note: the data can
not be changed

Purge Former Members
Select the 'Purge Former Members' menu option off the 'Member' menu.
All former members, who have been in the inactive file longer than the
date you specify here, will be removed.  They will no longer exist in any
datafile. Membership Director will report how many were removed.
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Financial Management
Membership Director provides a financial module that allows the
association the means to track the association's income and expenses.  It
can be used to record the checks issued, but will not print the actual
check.  It also records funds received in addition to dues and
contributions, i.e. grants, rebates, interest, etc. The various
income/expense reports provide a financial picture of the association's
finances.

Checks and Deposit Screen
This screen is composed of two pages.  The tabs at the top of the screen
may select these pages.

Checks Page
The Checks page resembles a check, which most people are familiar with.

Payee.  Membership Director allows quick access to a payee list of
persons or businesses that the association has previously written checks to.

Account - The list contains the accounts created in for the association.
If the account list is not satisfactory use the ‘Configuration’ menu, ‘Lookup
Codes’ and ‘Accounts, Financial’ menu options.

Deposits Page
Do not use this page to record dues received or contributions.  Doing so
would duplicate any dues or contributions recorded using the menu/tool
bar options for these two functions.  Use this page to record any other
income that is received - bank interest, grants, sales, refunds/rebates, etc.

Editing using the Checkbook Register
Once in the checkbook register highlight the item to be edited and click
the ‘Edit’ button.   Either Tab to or use the mouse to select the item to
correct.  If the amount is changed you will need to use the 'Recalculate
the Balances' button.  To delete a check highlight the check and then click
the ‘Delete’ button.

Opening Checkbook Balance
If the opening balance was not entered in the Setup Wizard it may be
inserted by:

Select the ‘Configuration’ Menu from menu bar
Select the ‘Organization’ menu option
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Click the ‘Edit’ button
Enter the amount in Checking Account Opening Balance.  This only

done once.  Once done this entry may not be accessed by the user.

Deposit Slip
The ‘Deposit Slip’ menu is found on the ‘Finances’ menu
Printing the deposit slip can facilitate making the deposit slip needed by

the bank
A bank deposit slip can be created to record all income received over

given period
The deposit slip includes the check numbers and amounts

Review Financial Transactions by Accounts
Membership Director provides an easy way to examine the financial
transactions.

Select the ‘Finances’ menu
Select ‘Financial Transactions’ menu option
Enter the beginning and ending dates (leave blank to review all)
Select the account to be reviewed
Either click the ‘Transaction’ tab or the ‘Review Transactions’ button.

You can only review data.  No Editing can be undertaken.

Financial Reports
Annual Income/Expense
Income/Expense Summary for given period
Income/Expense Compared with previous year (period)
Account Summary – 1 account
Account Summary – All Accounts
Checkbook Register
Payee Payments – help in preparation of 1099 form.
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Contributions Received
Contributions may be received from both members of the organization
and non-members.

Member Contributions
Select 'Contributions' from the Finances menu, then Members, or Select

the Contributions icon from the tool bar
Click 'New' button.
Enter data regarding the contribution received
Select type of contributions from drop down list
If cash, enter amount
If non-cash contribution enter a description of the non-cash item and
assign a value.

Contribution received from non-member
Select 'Contributions' from the Finances menu
Select 'Non-Member' menu option
If the donor is not already in the donor data files, select the 'New Donor'

button.  Enter the details about the donor and the donation.
If the donor has contributed previously, enter their last name to locate

them, and then click the 'New Donation’ button.  Change any information -
address, etc and enter the details of the new contribution.

Problem entering amount
If the amount field will not accept an amount use the HOME key to move
the cursor to the left in that field.  An alternative is to use the TAB key to
move from field to field as this places the cursor all the way to the far left.

Edit Contributions
Select 'Contributions' from Finances menu
Select either the 'Member' or 'Non-Member' menu option
Locate the donor
Click the 'Edit' button
Select the specific contribution in the lower grid
Select the 'Contribution' tab at the top of the page
Make the necessary changes and click the 'Save' button



32

Reports
There are over ninety pre-established reports for your use.  These are
selected from the Reports menu.  In addition there is a Custom Reports and
Letters option that together allows the user to have great access to the
membership data.

Previewing the Report

The preview toolbar is located at the bottom of each report and label screen.
You can print the report or labels by clicking on the printer icon. The options
(left to right) are:

Start Page - End Page:  Print selected pages
Copies:      Indicate the number of copied desired to be printed.
Collate:     Only available if your printer has this capability.
Save:     You may save the report as a HTML file.
Print:     Print the report being previewed.
View:     Change the page being viewed.
Redisplay Report: Refreshes the report.
First page:   Changes view to first page of report.
Previous page:  Changes view to previous page of report.
Next page:    Changes view to next page of report.
Last page:   This button changes view to last page.
Close:     Terminates report preview.

Letters, Merging Data
Membership Director allows the user to create letters in which data
from the data files is merged into the letter.  First,

Select the Reports Menu
Select the ‘Custom Reports & Letters’ menu option.  This brings up the

screen below:
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Create Letters
First click on the 'Select Data Table' button and select the data file you

want to use.
Most of the time the data file to select is 'MEMBERS.DBF'.  This file holds
most of the member information.  Other files for possible use include:
  Dues_pay.dbf  -  holds dues information
  Contrib.dbf -  holds contribution information of members
  Contbnm.dbf -  holds contribution information of non-members
  Award.dbf -   holds award information
  Comm_me.dbf -  holds committee information
  Int_memb.dbf -  holds interest information.
Note: A special field links ‘members.dbf’ file and these six data files.

Select the 'Select Text File' button, if a letter has previously been
prepared, and locate it.

If no letter has previously been prepared select the 'Create New Text
File' button and then type in a descriptive file name

Select a Font by clicking 'Change Font' button.  The font selected will
appear as <FT-xxxxx,12,xxx>.  See example above.

Use the Enter key to increase the space at the top for your letterhead or
desired beginning point on the page.

Type in the letter.  Where you want a data field to be merged, select a
field from the 'Insert Field' drop down list by double clicking on the field.
The field can be identified in the text by the <FN-xxxxx> where xxxx is the
field name. Use the Enter key to establish the right margin (there is no wrap).
You may want to print a letter to view the margins and then reset them
accordingly.
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Click the Save File button

Printing Letters
Select the "Merge Letters' as above if not already open
Select the 'Select Text File' button and locate the file
Click the 'Print' button

Select – Letter or Reports
Select the format for the report either letter or report.  Selecting the
'Report' radio button makes a list report with data in columns.  Just select
the fields for the report as above and print the same way.

Printer Setup
This is a standard window feature - change printers, change orientation,
paper size and tray.  This is found on the 'File' menu.

Disbursing a report to other members
There are two ways to save printed reports:

1. Use the Save button on the Preview to save as a HTML file.  Some
browser do not align columns correctly and thus not always the best
method.

2. A better method is to use a PDF writer.  Download and install them
as a printer driver on your computer.  One of these is PDF995.  To
create the PDF file select the PDF995 printer when you print the
report.

In either option provide a name in the dialog box when it asks for the file
name.  Attach the newly created file to email messages or place on a floppy
disk.

Labels
The membership type and expiration date may be printed on the first

line of the label if ‘Print Expiration and Membership Type on label’ option
was selected in Configuration.

Spouse names will be included in the name line of the address label if
you have answered 'Yes' in the Basic Organization Configuration to the
question 'Print member and spouse name on address labels?'

You can print envelopes in lieu of address labels if you have answered
'Yes' in the Basic Organization Configuration to the question 'Print
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envelopes in lieu of address labels?'
If you don't want the country code to be displayed on address labels -

leave the country code blank on the Membership Information Screen.
A member may have two different addresses.  Indicate on the

Membership Information Screen which one is the one to be used in printing
labels.

You may select the labels to be printed either alphabetical or zip code.

Label options
There are 19 pre-established labels.
1     All Members
2  Selected Members
3  Members in Single City
4 Members in Single State
5 Members in Single Country
6  Dues - All before given
expiration date
7    Dues – All after given
expiration date
8  Dues - All within given
period
9  Former Members
10 Membership Types - for
specific type

11 Officer/committee - for
specific committee
12 Interest - for specific interest
13  Contributors - All
14   Contributors - All within
given period
15  Chapters - single chapter
16  Special Flag - all members
having the special flag
17  Organizations Represented
18  Organizations Represented -
with names
19  Name Tags

Labels Supported
Membership Director supports 3 of the common Avery Address Labels.
You can change the Avery Label type by changing the association's label
default established in Configuration Menu.

The three Avery label types are:
Avery
No.

Size Labels
Across

Labels
Down

5160 2 5/8 x 1 3 10
5161 4 x 1 2 10
5162 4 x 1 1/3 2 7

Name Tags
Printed on Avery 8395 Name Badges - All members printed alphabetically
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A club logo will be printed on the name tag.

Membership Cards
Use Avery business card stock - for laser printers, 2 across x 5 down,
3.5" x 2.0" - Avery  5371 (white) 5377 (gray) and 5376 (ivory).
Print all or individually
All with Special Flag setting (one letter designation)
The club’s logo will be printed on the card.

Meeting Notices
Use Avery #3262 card stock - 2 across, 2 down, printed landscape
Enter the date, time, location, and program
Then print the meeting notice to all or select members
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File Management
Selecting the 'File' option on the menu bar will display four file
management menu options.

Indexes
Indexes maintain the order of the data.  Should you observe the data on
reports or in data input screens not appearing to follow the established
order, i.e. names out of order, codes not in proper sequence, unknown
data being displayed, then it is possible that the indexes have become
corrupt.  Data and index files become corrupt by sudden power
fluctuations or loss of power at critical times or turning off the computer
without closing it down properly.

There are two possible solutions.  Either reindex the data files or restore
them from backup.  The first choice is to reindex.   If this doesn't correct
the problem then restore valid files from your backup.

Re-indexing Data files
Select 'Indexes' from File Menu
Select 'Rebuild Indexes' menu option
All indexes will be rebuilt

Remove Deleted Records
When records are deleted they are not actually removed, only marked for
deletion.  Sometimes this may cause some report to display counts more
than they are.  Selecting the 'Remove Deleted Records' menu option will
'pack' the data files.

Backup Data files
It is highly recommended that you backup up the data files on a regular
basis - at end of each session, daily, or, as a minimum, weekly.

The Backup Data Files option copies the data files to 3 files on your hard
drive and, if selected, also to your default drive.  The names of the three
files are MDBack1.PAK, MDBack2.PAK and MDBack3.PAK.

To backup:
Select 'Backup Data files' option from File Menu
Select the 'Yes' radiobutton if you want to backup up to both your hard

drive and your default drive.  The default drive is the drive you designated in
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the Configuration setup. Note this can include the hard drive or Zip Drives.
Insert the disk and click 'Start Backup' button.

Select the 'No' button, if you only desire to backup to the hard drive, and
then the 'Start Backup' button.

      When backing up to a floppy disk Membership Director will alert you if
a disk is full.  When this occurs remove the disk and label it and insert
another disk.  Continue this if prompted.  Place disks in safe storage place
should restore data files become necessary.

NOTE:  Larger organizations will need to backup to Zip Drives as the files
may not fit on 3.5 inch floppies.  If the data files will not fit an error message
will be received.  Backup is not possible to CD ROM RW drives.

You can choose to backup manually using Window Explorer or My
Computer.  If you do, copy all ".dbf, .dbt and .mdx" files to your backup
disk.

Restore Data files
If rebuilding the indexes has not corrected the problem of corrupted data
then the only remaining solution is to restore valid data from your backup
files.

Select 'Restore Data files' from File Menu
Click on the wrench to the right of Get Backup File and select one of the

three *.PAK files. All the *.PAK files are located in the \Tables folder
(C:\MEMB_DIR\TABLES).   Once selected a list of files will be displayed.
MDBack1.PAK contains all lookup codes.  MDBack2.PAK contains all files
containing member data (dues, awards, contributions, interests and
committees plus financial data).  MDBack3.PAK contains the individual
membership data.  See next page for a listing of files in each .PAK file.

You can 1) restore all files in all PAK files, 2) restore all files in one
PAK file or 3) restore a single file from a single PAK file.

If corruption is only noticed in one file select the appropriate file, then
click Restore One File.  Select Restore All to replace all listed files.  If the
backup files are not up to date significant data entry may be needed to bring
the restored files up-to-date.  This is the primary reason to backup data on
regular basis.

If you are transferring files to another officer’s computer select restore
'All Files From All PAK Files'.

When you restore data from your backup files it gives the old file a
.BAK extension.
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Backing up on one computer and restoring to a second computer
The 'Default' drive always means where the backup disk will reside.
Normally this is 'A' drive but could be any external or removable drive.  The
backup will always write to the hard drive but you normally want it to write
to both the hard drive and the removable disk drive.

So after backing up to the floppy on the first computer take that floppy to the
second computer.  On the second computer you need to use the Restore
Datafiles procedure to copy the data from the floppy/removable disk to the
second computer’s hard drive.  Be sure you must select the floppy/removable
drive so the .PAK files from the floppy/removable disk are displayed.  If you
select C: (the hard drive) then the data you restore is not the new data from
the floppy/removable disk, that is the data from the first computer, but the
data you backed up previously on this, the second computer.

Caution:  Using the Restore Datafiles option completely overwrites the
datafiles on the hard drive of the second computer.  After restoring the data
on the second computer will be a duplicate of the files on the first computer.
The backup from the first computer will have replaced any work done on the
second computer data files.

Different Officers Using Different Parts of Membership
Director
When the responsibilities for membership and treasurers are split between
more than one officer the backup of data files and restore of data files must
be carefully managed as cautioned above.

 The backup creates three .pak files.  These are compressed and each
contains up to a dozen datafiles (.dbf and .dbt files) that Membership
Director uses to store the data.

MDBack1.pak contains the lookup codes - account.dbf, award.dbf,
chapcode.dbf, config.dbf, contcod.dbf, country.dbf, err_log.dbf, former.dbf,
history.dbf, int_code.dbf, mtg_date.dbf, off_code.dbf, officer.dbf, event.dbf,
commcode.dbf, state.dbf, typememb.dbf, user_def.dbf.  The only one with
financial info is account.dbf.

MDBack2.pak contains attend.dbf, awrd_mem.dbf, check.dbf,  chk_no.dbf,
contrib.dbf, contbnm.dbf, dues_pay.dbf, awrd_mem.dbt, int_memb.dbf,
off_memb.dbf, payee.dbf.  Four of these files include the financial data -
check.dbf, chk_no.dbf, contrib.dbf and dues_pay.dbf.  The others include
data of the member’s involvement in your organization.
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MDBack3.pak contains members.dbf and members.dbt.  This file contains
the member information.

So if you backup and do a selective restore - only restoring the data used by
each other.  It can work but you always need to restore one file at a time, a
little time consuming.

A separate license will be required for each computer running the program.

Transfer to new officer
Periodically the need exists to transfer membership responsibilities to a
new officer.  Here are the recommended steps to take in making this
transfer.

The old officer should make a backup of all data files (use 'Backup Data
files' in File Menu) OR copy all files with extensions of .dbf, .dbt and .mdx
to transfer disk.

The New officer should download the latest version from Advanced
Data Solutions’ web site (www.ads-software.com/download.htm) - but
DON'T INSTALL*.

The New officer should create two new folders on his/her computer –
first C:\MEMB_DIR.  Then the second one within the first –
C:\MEMB_DIR\TABLES.  Copy the data files from transfer/backup disk
received from the old officer into this, the tables folder.  NOTE: the data
files include files with extension of .dbf, .dbt and .mdx

Now the new officer should open and install the downloaded file.  This
places all the new files into the c:\memb_dir folder.  Run Membership
Director.  It will recognize the data from the earlier version and ask if it is to
be retained.  Answer 'Yes' and, after it moves the data from the old datafiles
into the new datafiles and then will reindex them and then you are ready to
go.

Record the Registration key received from Advanced Data Solutions.
Otherwise you will not be able to enter any new members because without
the registration key Membership Director assumes it is a demo.

*  It is possible that a new version will have new data fields.  Therefore
don't use the Restore Data files menu option to transfer the data files.
This copies the old or backup data on top of the existing data files thus
wiping out the new data file format. Placing the old data files in the
c:\memb_dir\tables folder first allows Membership Director, when it is
run, to identify that old data exists and give the user the option to retain
the old data or start with blank data files.

http://www.ads-software.com/download.htm
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Sharing Data
A frequent question we receive is ‘how can the data be shared with other
officers of the club?’

1.  If the other officers have a need to add information, edit information and
run reports at the same time then you need to be networked.  Each machine
would need a software license.  We offer volume discounts depending on the
number needed.

2.  If the other officers only need access to various reports you can save the
reports as HTML files or obtain a PDF writer program and install it on your
computer.  The PDF writer places a printer driver on your machine.  When
you print a report you select this printer driver to print.  It actually creates a
.pdf file, which you then give to your officers.  A free PDF writer is
PDF995.  There are others. You can find them through a Google search.

3.  Those users with Microsoft Access or Excel, or similar programs, can
open a copy of the main datafile(s) in these programs.  All the Membership
Director data is stored in .dbf files.  Access and Excel can open and work
with these files.  But notice we said 'a copy'.   We do not recommend using
these programs to work directly with the actual datafile.  There is a fair
chance the datafile could become corrupted and then you couldn't use it with
Membership Director.  Also note that the data Membership Director
maintains is found in multiple data files.  These data files are linked within
MD. Other programs will not provide this linking so you may not get the
results you desire.

4.  You can use the Update Master option.  See ‘Update Master’.

Security
A userID and password are required to activate Membership Director.
These establish a security level for the user.

Security Levels

1  The lowest level.  A user with this security level can enter individual
membership information, individual contributions and other data entry.
They cannot:

Write or Edit Checks
Change passwords
Create new users
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2   This level can write checks.    They however cannot:
Change passwords
Change security levels
Can not create new users

3   The highest level.  A user with this security level can:
Create new users
Change Passwords
Change security levels

Changing Security Levels
Select Configuration menu
Select ‘Change Security’ menu option
If you have a level 3 security then the Change Password screen is
displayed.  This screen functions as any other lookup code.

LogOn as New User
While Membership Director is running you can switch from one user to
another thus changing the security level.  Select the File Menu and ‘LogOn
as New User’ then enter the new password and you are now logged on with
the new security level.

History
Membership Director allows you to maintain a history of your
association.

Select the Other Menu
Select Organization's History menu option
Enter your officers, no. of members and major accomplishments
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Troubleshooting/Problem Solving

Error following installation
If Membership Director is installed in a folder with space in folder name
the user will get the following error upon starting the program and entering
the User ID and password.

Module: Mem_DirApp:
Line: 1476
Error no. 97
Error message: Unallowed phrase or keyword.

Solution: Uninstall the program from Control Panel and reinstall to the
default location - C:\Memb_Dir folder.

Database Engine Error - Invalid Index Descriptor
Database Engine Error - Unsupported Capability
Both of these errors have been reported after installation and when
running Membership Director for the first time. Membership Director
will appear to be caught in a loop, giving the same error but different line
numbers.  To Exit from the loop use Task Manager/Close Program
(CTRL + ALT + DEL keys on your keyboard) to End Task for the Error
Message.  Something is not compatible in your computer's BIOS with the
database engine that we use.  Upgrade the BIOS by downloading a file
from the computer's manufacturer website and then restarting the
Membership Director.  Be sure to follow the BIOS installation
instructions.

Corrupted Data
Re index data files - see Indexing
Restore from backup files - See Restore Data files

File in use by another
This error may be received usually after an error.  The error leaves a data
file open.  The operating system then sees it as being in use.  The only
solution is to reboot the machine to clear the mistaken impression that the
file is in use on network by another user.

Program Error
We have tried to provide you with a quality program.  Occasionally a bug



44

creeps in. When the Program Alert screen (see Next Page) is displayed,
Membership Director has detected a problem.   Record the ‘Error
Details’. Close the Program Alert screen.  If the program continues
satisfactorily you shouldn't do anything further.  If you get immediately
subsequent messages use Task Manager or Close Program (press CTRL +
ALT + DEL keys to activate) and select ‘End Task’ on the error message.
Then repeat what you were doing. If this problem occurs again forward
the ‘Error Details’ from the screen or the ERR_LOG.DBF file to us..  The
ERR_LOG.DBF file is found in the c:\memb_dir folder.  It contains the
error detail information on this screen and is helpful in isolating your
problem.

Customize the 10 customizable fields
From the Configuration Menu select 'User Defined Info' option.  The
Organization Specific Information screen allows you 10 fields to collect
specific information the organization wants collected that aren’t already
collected by Membership Director.  For each field you must enter the
Screen Label (how it will appear on the screen).  Save and then, when in
the Membership Information screen, select the 'User Custom' tab to
access the user-defined fields.  They will be displayed with the label you
just created. The label informs the user what information to enter for each
member.
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Unable to create control
Your computer has run out of resources (system or user resources).  Close
down any unneeded programs or reboot.  Rebooting the computer is the
best as it frees up any resources not released by other programs.

Error: Class does not exist:  MAINMENU::MENUXX_ONCLICK
This error will occur following another error that causes the menu to be
closed unexpectedly.  Close Membership Director and restarting it will
clear this error.

Unable to print labels
First be sure that you have a label type selected in Configuration.  This is
the most common problem.  Membership Director must have a label type
to print a label.  Second be sure you have one of the 'Use this for Mailing'
checked for each person.

Installation & Download Problems
Firewalls often prevent downloads of .exe files.  Disable the firewall
temporarily and try again.
Some popup stoppers program can interfere with installation examples
include Pop Up Stopper and AdSubtract.  Disable them and try again.

Import Data Errors
Selecting the wrong field may result in the following error:

 Unexpected Error
 Data Error: Unknown or wrong data

Data displayed incorrectly after import

Telephone numbers are stored as numbers only with no formatting.  If you
import the telephone number as (555)121-1212 then they will be displayed
later as ((55)5)1-21-1 so before you import change the telephone data to
numbers only i.e., 5551211212 with no formatting.
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Code 110 error while indexing
This error is also caused by a previous error that locks a file so the indexing
cannot be completed.  Exit from Membership Director and restart.

Database Engine Error: Read failure: \resttemp.DBF
Download and install the most recent build

Memory Access Violation
This error occurs occasionally when the operating system and program try to
use the same memory location.  The program adjusts, and in this case prints
the report, but the operating system still puts up the 'memory access
violation' message.  If it is repeated it may be a sign that your memory is
being fully used.  If so then close the program and try again.  Closing the
program tells the operating system to free up the memory it is using.

Vistas  - use Windows XP SP2 compatibility mode
Vista has 'Windows XP SP2 compatibility mode'. This mode is created to
prevent the "This program might not have installed correctly" dialog box that
shows for applications that are hard coded to look for the XP version.
Set the 'Windows XP SP2 compatibility mode' by:

Right-click on an .exe name or shortcut – go to Properties - under the
Compatibility tab - apply the Windows XP SP2 compatibility mode
to allow the application to work as it did on Windows XP.

Import Data
Importing information about your members (name, address, telephone
numbers, last dues payment, etc) can be accomplished using the File menu
and Import menu option.  However data such as dues paying history,
contributions history and other similar data cannot be assimilated into the
existing data structure.

Importing data from another source is a several-step process. The Import
Data form will attempt to lead you through this process based on the type
of data you are importing FROM, and the table you are importing TO.
The data source file will be called the "Source" and the table you are
importing the data into will be called the "Target" throughout the process.
You may have several choices as the process continues, and you may
cancel at any time.

Step One - Select the Data Source
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There are five types of data sources that you may use.
CSV - Comma Separated Values
Separated by other character
DBF - dBase format

Comma Separated Values (CSV) - The data may have quotes around text
fields, and a separator between all field types that is not a comma. This is in
a text file that can be opened in any text editor. Select separator from list
(below) or enter separator (single character).  A CSV file may have a file
extension of .TXT, .CSV or just about anything.

Separated by other character - The data may have quotes around text fields,
and comma separators between all field types. This is in a text file that can
be opened in any text editor.

Step Two - Provide name and location of Data Source

Click the button to the right of the entryfield.  In the following dialog box
locate the folder and source file to be used.

Step Three - Identify target file

Most of the data to be imported will have 'MEMBERS.DBF' as the target
file.  This file resides in the "C:\MEMB_DIR\TABLES" folder (default
location).  It is not recommended to import data into any of the other data
tables, as it is unlikely the structure of the old source file would match that of
the current tables.

Step Four - Map the Destination file to the Imported file

This step matches the Target fields to those in the Source file.  Each field
must have either a field name or 'Ignore'.    Data from the first three records
are displayed so you can see what field to assign.  If not sure choose 'Ignore'
which is the last item on the field lists.  Selecting the wrong field may result
in the following error:

 Unexpected Error
 Data Error: Unknown or wrong data

At this point you need, for each field in the "Source Field" list shown, to
assign a field name, a field type, a width, and if the field type is numeric, a
number of decimal places. To do this follow these steps for each field

1. Select a field in the list, in the order you want it to appear in the
new table. (The contents of that field from the first rows will appear
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in the list below the first one.)
2. Enter field name, select type, select width, and select decimals.

NOTE: if you do not wish to import a field, select "Ignore" in the
fieldname option.  For each field there must be a field name or the
word ‘Ignore’.

3. Click the "Add Field" button
4. Repeat for each field

Export Data
Step One - Select the fields to export

All fields - by selecting the 'Select All Fields' button.
Drag desired field from column to the white square in the lower half

of the screen.  Or Double-click the desired field.
If a field was moved in error, double click it

Step Two -Click the Export Tab and then select the export option desired.
Options included are:

Comma Separated Value
Other Separator – must designate the separator
SDF (Standard Data Format)
HTML
DBF

Step Three – Give the export file a name

Using Different Languages
Membership Director can allow you to use a language that has different
characters like 'çéã' in it.

Open the Character Map that you will find in the Windows Accessories
Menu.  Click on the desired character you want and then click the copy
button.  Then in Membership Director at the spot where you want the
character use the CTRL + V keys and it is pasted in.  All of the keys
listed above and more are available to be used.

These characters, however, may not print unless the printer can access the
international character set.

Updating Master Files
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Associations may have a national office and chapters with the need to
maintain membership information at both levels.  At the national office
the need is to have consolidated data from all chapters.  At the chapter the
need is to only have chapter data.  The chapter must submit their
membership data to the national office where the national office
assimilates it into the national data file.

The chapter first purges their membership to remove those who are no
longer members.  This creates a data file of the removed members.  It and
the current membership data files are transferred by diskette or email to
the national office.  At the national office the removed data file is used to
remove those who are no longer members from the consolidated data
files.  The current data file chapter is used to check against the existing
data file for any changes or new members.

NOTE:  Updating a master file only transfers general information from
the chapter’s member - name, address, telephone, etc.  The latest dues
payment, date of expiration and current membership category are
transferred but the member's dues history, contribution history,
organization history, attendance, lookup codes are not forwarded.

The update process for Chapters
Preparing to send data

Select 'Member' menu
Select 'Purge Member' - All expired persons as of a given date
are transferred to inactive files AND a file is created containing
the removed persons (removed.dbf).

Sending data to primary unit (HQ, National, International)
Select 'File' menu
Select 'Update Master' menu option
Place blank disk in default drive (One you established in
Configuration)
Select 'Send Files' menu option
Label disk with appropriate information and send.
An alternative is to send files via email.  Attach two files to email
message
1  Members.dbf
2  Removed.dbf

The update process for National Offices - Updating master data
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file using sub-unit (chapter, club) data
Copy files received via email to special folder
(C:\MEMB_DIR\TEMP).  Normally there will be two files
(members.dbf, removed.dbf).
If you have received multiple updates you must give each a new
unique name when other files are already there.  Call the second ones
copied there - members1.dbf and removed1.dbf, the third
members2.dbf and removed2.dbf, etc.
Or place the data received from the chapters on floppy disk in your
floppy disk drive
Select 'File' Menu
Select 'Update Master' menu option of File menu
Select 'Update Master' menu option of Update Master menu
Membership Director will ask for the location of the data - either
the default floppy disk drive or a special folder
(C:\MEMB_DIR\TEMP)
After updating Membership Director will indicate how many
members were added, changed or deleted.  All files on the floppy
disk or in the special folder are then moved to the folder
C:\MEMB_DIR\UPDATED leaving the folder
(C:\MEMB_DIR\TEMP) empty.

Updating Membership Director
Determine what version you are currently running by selecting the
'About Membership Director' in the Help menu.  The version and the
build date can be found here.
Registered users may obtain the latest release to their version free by
downloading the demo program from

 www.ads-software.com/download.htm.
Your registration key will convert the demo to the full program.

Download the latest file.
Open the downloaded file and the files will be uncompressed and
installed.
Run Membership Director. It will recognize the existence of earlier
data and ask the user if the earlier data is to be retained.
You may have to re-enter the Registration Key furnished by Advanced
Data Solutions

Uninstall Membership Director
Remove the folder c:\memb_dir
Delete any shortcuts

http://www.ads-software.com/download.htm.
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Networking
Membership Director is networkable.   Follow the steps below to install it
on your network.

Install the program on all network machines
Remove the data files (.dbf, .dbt and .mdx files) on all but the computer

that will serve as the data server
On all computers, other than the one acting as the data server, map the

drive to the data server computer.  Your Network Administrator will have to
do this.

Open the BDE Administrator.  This is found in the Membership
Director v.2.0 Menu group.

Click the Database tab if it is not active
From the list of databases click on MEM_DIR to highlight it.
Select the Object menu
Click on Delete to remove it
Select the Object menu again
Click on New
Enter 'MEM_DIR' as the name in place of 'Standard'
On the right 'Definition' side of the BDE Administrator with MEM_DIR

highlighted change Default Driver from the default 'Paradox' by selecting
'Dbase' from the drop-down list.

Also on the right side change the Path by using the Browse button (...)
and point to the mapped drive and folder (should be' MEMB_DIR') oN the
computer acting as the data server.

NOTE:  An additional license is needed for each computer running
Membership Director on a network.

Using with Window's Vista across a network
When launching this program across the network on another workstation or
server you may get the 'Unknown Publisher' warning. At this time, the
following option are available to suppress this warning:
 In Internet Explorer from the Toolbar goto Tools | Internet Options.
Under the 'Security' tab highlight the Local Intranet section. Click the 'Sites'
button. Click 'Advanced' and add the server's address to the list of trusted
zones.
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Managing Multiple Organizations

Membership Director can only track information about one organization,
however, you can install Membership Director two or more times on the
same machine to track different organizations.  Each installation should be to
a different location.  Do not install to any locations that contains a space in
the folder name (i.e. "Program Files") OR the folder name longer than 8
characters.  Each installation must have a unique shortcut in the Start menu
and the computer desktop to it's own location.

Caution:  Do not run more than one installation at the same time.  Close out
one before starting a subsequent organization or you may encounter data lost
or transfer between the organizations.  Also, when you upgrade to different
builds you must do the upgrade to each installation.
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Shareware
Shareware is a distribution system for computer software based on the
"try-before-you-buy" principle. If you like the program, then you make a
registration payment to the author. If you don't want the program after
trying it out, then you delete it or pass it along to a friend.

Shareware is NOT freeware. To legally use a program that has been
distributed as Shareware you MUST pay for it.  Registration gives the
user extra benefits such as the latest version on disk, technical support,
upgrade discounts and enhanced program functionality

ASP Ombudsman Statement

Advanced Data Solutions' is a member of the Association of Shareware
Professionals (ASP).  ASP wants to make sure that the shareware
principle works for you. If you are unable to resolve a shareware-related
problem with an ASP member by contacting the member directly, ASP
may be able to help. The ASP Ombudsman can help you resolve a dispute
or problem with an ASP member, but does not provide technical support
for members' products. Please write to the ASP Ombudsman at 157-F
Love Ave, Greenwood, IN 46142 USA, FAX 317-888-2195, or send
email to omb@asp-shareware.org.

Advanced Data Solutions

Advanced Data Solutions develops specialized software to aid officers in
managing associations.   We welcome your feedback on this program.
Your suggestions for new features, reports, corrections, and other
comments will help us develop improved versions for future releases.

Advanced Data Solutions can be reached at:

Advanced Data Solutions
P.O. Box 714
Luray, Virginia 22835
540-743-4910

Our website has the very latest
release.

Email for Technical support to
support@ads-software.com

mailto:omb@asp-shareware.org
mailto:support@ads-software.com
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License -Membership Director

ADVANCED DATA SOLUTIONS LICENSE STATEMENT AND LIMITED
WARRANTY

Advanced Data Solutions grants you the right to use this software product ("Software"),
including any accompanying documentation, in the manner provided below.

This Software is owned by Advanced Data Solutions or its suppliers and is protected by
copyright law and international copyright treaty. Therefore, you must treat this Software like
any other copyrighted material (e.g., a book), except that you may either make one copy of
the Software solely for backup or archival purposes or transfer the Software to a single hard
disk provided you keep the original solely for backup or archival purposes.

This license allows you to use the Software on one (1) machine.

You may transfer the Software and documentation on a permanent basis provided you retain
no copies and the recipient agrees to the terms of this license statement.  Except as provided
in this statement, you may not transfer, rent, lease, lend, copy, modify, translate, sublicense,
time-share or electronically transmit or receive the Software, media or documentation.  You
acknowledge that the Software in source code form remains a confidential trade secret of
Advanced Data Solutions and/or its suppliers and therefore you agree not to modify the
Software or attempt to decipher, decompile, disassemble or reverse engineer the Software,
except to the extent applicable laws specifically prohibit such restriction.

If you have purchased an upgrade version of the Software, it constitutes a single product
with the Advanced Data Solutions software that you upgraded. You may use or transfer the
upgrade version of the Software only in accordance with this license statement.

This Software is subject to U.S. Commerce Department export restrictions, and is intended
for use in the country into which Advanced Data Solutions sold it (or in the EEC, if sold into
the EEC).

LIMITED WARRANTY This software is provided "as is," without warranty of any kind,
Advanced Data Solutions warrants that the Software, as updated and when properly used,
will perform substantially in accordance with the accompanying documentation, and the
Software media will be free from defects in materials and workmanship, for a period of
ninety (90) days from the date of receipt. Any implied warranties on the Software are
limited to ninety (90) days.  Some states/jurisdictions do not allow limitations on duration of
an implied warranty, so the above limitation may not apply to you.

Advanced Data Solution's and its suppliers' entire liability and your exclusive remedy shall
be, at Advanced Data Solution's option, either (a) return of the price paid, or (b) repair or
replacement of the Software that does not meet Advanced Data Solution's Limited Warranty
and which is returned to Advanced Data Solutions with a copy of your receipt.  DO NOT
RETURN ANY PRODUCT UNTIL YOU HAVE CALLED Advanced Data Solutions AND
OBTAINED A RETURN AUTHORIZATION NUMBER.  This Limited Warranty is void if
failure of the Software has resulted from accident, abuse, or misapplication.  Any
replacement Software will be warranted for the remainder of the original warranty period or
thirty (30) days, whichever is longer.  Outside the United States, neither these remedies nor
any product support services offered by Advanced Data Solutions are available without
proof of purchase from an authorized non-U.S. source.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ADVANCED
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DATA SOLUTIONS AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,  IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE AND WARRANTIES OF NON-INFRINGEMENT, WITH REGARD TO THE
SOFTWARE AND THE ACCOMPANYING DOCUMENTATION. THIS LIMITED
WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE OTHERS, WHICH VARY FROM
STATE TO STATE OR JURISDICTION TO JURISDICTION.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT
SHALL ADVANCED DATA SOLUTIONS OR ITS SUPPLIERS BE LIABLE FOR ANY
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF
BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF
THE USE OF OR INABILITY TO USE THIS ADVANCED DATA SOLUTIONS
PRODUCT, EVEN IF ADVANCED DATA SOLUTIONS HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.  BECAUSE SOME
STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

GENERAL PROVISIONS This statement may only be modified in writing signed by you
and an authorized officer of Advanced Data Solutions.  If any provision of this statement is
found void or unenforceable, the remainder will remain valid and enforceable according to
its terms.  If any remedy provided is determined to have failed for its essential purpose, all
limitations of liability and exclusions of damages set forth in the Limited Warranty shall
remain in effect.

This statement shall be construed, interpreted and governed by the laws of the State of
Virginia, U.S.A.  This statement gives you specific legal rights; you may have others which
vary from state to state and from country to country.  Advanced Data Solutions reserves all
rights not specifically granted in this statement.
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